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Before You Begin

Welcome to the RISA-3D General Reference manual. Please read this topic prior to installing the program and
pay particular attention to the License Agreement. If you are a first time user of RISA-3D you should turn your
attention to the Tutorials (a separate document) which are designed to get you up and running as fast as pos-
sible while still exposing you to the important features of the software.

The Tutorials are designed to be read in two ways. If you are already familiar with structural modeling in gen-
eral you can skip the supporting text and read only the underlined action items to quickly move through the
tutorial. If you want more thorough explanations of the modeling process you may read all or some of the sup-
porting text as you see fit.

After you have gone through the Tutorials, use this General Reference for detailed information on any topic. The
topics are arranged in alphabetical order and are thoroughly indexed.

Overview

RISA-3D is a general-purpose 3-dimensional analysis and design program. This program has been developed to
make the definition, solution and modification of 3D structural models as fast and easy as possible. Analysis, up
to and including calculation of maximum deflections and stresses, may be done on structures constructed of any
material or combination of materials. Complete steel and wood design are also included in the program.

RISA-3D has full graphical modeling capability. You can draw your model on the screen and also perform extens-
ive graphical editing simultaneously in multiple views. To modify your model data directly, RISA-3D employs a
powerful, proprietary spreadsheet. All this combined with flexible data generation algorithms makes modeling
very easy. Graphic display of the model along with applied loads, boundary conditions and much more, is always
available. The model can be rapidly edited, solved, viewed, modified, re-solved, etc. The truly interactive nature
of RISA-3D is its primary strength. RISA-3D is also able to perform elaborate error checking as you define the
model, and offers context sensitive help every step of the way.

RISA-3D is an interactive program as opposed to a batch mode program. With a batch mode program, you would
edit a text file in one program (typically called a pre-processor), and then solve it with another program, and
then view the solution results in yet another program (typically called a post-processor). With RISA-3D, all
model editing, model solution, and results browsing is accomplished through the same interface and with the
same program. The interactive approach offers several unique advantages over batch mode which include; the
ability to do real time error checking of your model data, the ability to do rapid model editing, solution, editing,
and re-solution without jumping from one program to another, and the need for the user to learn only one pro-
gram interface.

You may access the features in RISA-3D by using the menu system, or the toolbars. The best way to learn RISA-
3D is to go through the Tutorials. The advantage to this is that you are exposed to the tools RISA-3D provides
and the ways that you can take advantage of them.

Minimum System Requirements

One of the following operating systems is required:

o Microsoft Windows 10 (64 bit only)
o Microsoft Windows 8.1 (64 bit only)
o Microsoft Windows 7 SP1 (64 bit only)

Internet (Subscription License Only)

An internet connection is required to launch the program. The internet connection must be maintained as long as
the program is open, although brief internet outages (a few minutes) do not affect the user's ability to keep the
program open.
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Hardware

The following hardware is required:

o 1 GHz or faster processor (x86-64)
o 1024x768 or higher monitor resolution
e 2 (or more) button mouse, mouse wheel recommended

« 8GB of RAM
e 4 GB of hard disk space

Program Limits

Software Limitations

Joints 500,000

Members 100,000

Plates 250,000

Shapes 100,000

Wall Panels 10,000

Openings/Regions (per Wall Panel) 25/100

Solids 250,000

Section Sets 10,000

Loads (All Types Combined) 300,000
Materials 500
Custom Wood Species 500
Diaphragms 500
Basic Load Cases 1,000
Moving Loads 500
Time History Functions 500
Load Combinations 5,000
Mode Shapes 2,000
Time History Load Functions 500

Demonstration Version: While you can open and solve a larger model, the largest model that can be saved to
disk with the demonstration version is limited to 40 Joints, 40 Members, 40 Plates and 4 wall panels.

Also, the Demonstration Version will automatically shut down if left open for 24 continuous hours.

License Agreement

END-USER LICENSE AGREEMENT FOR RISA TECH, INC. SOFTWARE

The RISA-3D software product (SOFTWARE PRODUCT) includes computer software, the associated media, any
printed materials, and any electronic documentation. By installing, copying, accessing or otherwise using the
SOFTWARE PRODUCT, you agree to be bound by the terms of this agreement. If you do not agree with the terms

RISA-3D V16



Before You Begin

of this agreement RISA Tech, Inc. is unwilling to license the SOFTWARE PRODUCT to you. In such event, you must
delete any installations and destroy any copies of the SOFTWARE PRODUCT and return the SOFTWARE
PRODUCT to RISA Tech, Inc. within 60 days of purchase for a full refund.

Copyright © 2018 by RISA Tech, Inc. All rights reserved. RISA is part of the Nemetschek Group. The SOFTWARE
PRODUCT is protected by United States copyright laws and various international treaties. All rights not spe-
cifically granted under this agreement are reserved by RISA Tech, Inc. “RISA” as applied to structural engin-
eering software is a registered trademark of RISA Tech, Inc.

1. SOFTWARE LICENSE. The SOFTWARE PRODUCT is licensed, not sold. All right, title and interest is and
remains vested in RISA Tech, Inc. You may not rent, lease, or lend the SOFTWARE PRODUCT. You are specifically
granted a license to the use of this program on no more than one CPU at any given time. The Network Version of
the SOFTWARE PRODUCT is licensed for simultaneous use on a certain maximum number of network stations
that varies on a per license basis. The Subscription Version of the SOFTWARE PRODUCT is licensed for sim-
ultaneous use on a certain maximum number of CPU’s that varies on a per license basis. As part of the license to
use the SOFTWARE PRODUCT, the program user acknowledges the reading, understanding and acceptance of all
terms of this agreement. The SOFTWARE PRODUCT may not be reviewed, compared or evaluated in any manner
in any publication without expressed written consent of RISA Tech, Inc. You may not disassemble, decompile,
reverse engineer or modify in any way the SOFTWARE PRODUCT. If the SOFTWARE PRODUCT was purchased at
a discounted price for educational purposes it may in no event be used for professional design purposes. The
terms of this license agreement are binding in perpetuity.

2. DISCLAIMER. We intend that the information contained in the SOFTWARE PRODUCT be accurate and reliable,
but it is entirely the responsibility of the program user to verify the accuracy and applicability of any results
obtained from the SOFTWARE PRODUCT. The SOFTWARE PRODUCT is intended for use by professional engineers
and architects who possess an understanding of structural mechanics. In no event will RISA Tech, Inc. or its
officers be liable to anyone for any damages, including any lost profits, lost savings or lost data. In no event will
RISA Tech, Inc. or its officers be liable for incidental, special, punitive or consequential damages or professional
malpractice arising out of or in connection with the usage of the SOFTWARE PRODUCT, even if RISA Tech, Inc. or
its officers have been advised of or should be aware of the possibility of such damages. RISA Tech, Inc.’s entire
liability shall be limited to the purchase price or subscription price of the SOFTWARE PRODUCT.

3. LIMITED WARRANTY. RISA Tech, Inc. warrants that the SOFTWARE PRODUCT will operate but does not war-
rant that the SOFTWARE PRODUCT will operate error free or without interruption. RISA Tech, Inc.’s sole oblig-
ation and your exclusive remedy under this warranty will be to receive software support from RISA Tech, Inc.
via telephone, email or fax. RISA Tech, Inc. shall only be obligated to provide support for the most recent version
of the SOFTWARE PRODUCT. If your version of the SOFTWARE PRODUCT is not the most recent version RISA
Tech, Inc. shall have no obligation to provide support in any form. Except as stated above the SOFTWARE
PRODUCT is provided without warranty, express or implied, including without limitation the implied warranties
of merchantability and fitness for a particular purpose.

4. PROTECTION DEVICE. In the event the SOFTWARE PRODUCT requires the use of a PROTECTION DEVICE to
operate, you are specifically prohibited from attempting to bypass the functionality of the PROTECTION DEVICE
by any means. A lost or stolen PROTECTION DEVICE will not be replaced by RISA Tech, Inc.

5. SUBSCRIPTION SERVICE. In the event the SOFTWARE PRODUCT is accessed via a SUBSCRIPTION SERVICE,
RISA Tech, Inc. shall make the SUBSCRIPTION SERVICE available for your use via an internet connection for the
Term of the Subscription Agreement. At the end of the Term of the Subscription Agreement your right to access
the SOFTWARE PRODUCT via the SUBSCRIPTION SERVICE will terminate unless the Subscription Agreement is
renewed. RISA Tech, Inc. does not guarantee the SUBSCRIPTION SERVICE will be available error-free or unin-
terrupted. You acknowledge RISA Tech, Inc. does not control the transfer of information over the internet and
that the SUBSCRIPTION SERVICE may be subject to interruptions or delays beyond the control of RISA Tech, Inc.
RISA Tech, Inc. is not responsible for any delivery failures or any other damages resulting from any problems
with the SUBSCRIPTION SERVICE.
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6. TERMINATION. RISA Tech, Inc. may terminate your right to use the SOFTWARE PRODUCT if you fail to com-
ply with the terms and conditions of this agreement. In such event, you must delete any installations and destroy
any copies of the SOFTWARE PRODUCT and promptly return the SOFTWARE PRODUCT to RISA Tech, Inc.

7. CHOICE OF LAW. By entering into this Agreement in accordance with Paragraph 1, above, you have agreed
to the exclusive jurisdiction of the State and Federal courts of Orange County, California, USA for resolution of
any dispute you have relating to the SOFTWARE PRODUCT or related goods and services provided by RISA Tech,
Inc. All disputes therefore shall be resolved in accordance with the laws of the State of California, USA and all
parties to this Agreement expressly agree to exclusive jurisdiction of, and venue in, the courts in Orange County,
California, USA. No choice of law rules of any jurisdiction apply.

8. PRIVACY POLICY. All information you provide and have provided, or which we otherwise collect and have col-
lected, through or in connection with the SOFTWARE PRODUCT, including personally identifiable information
about you, is subject to, and will be treated in accordance with, the then-current Privacy Policy located at
http://risa.com/privacy, which is incorporated herein by this reference. By accessing, downloading, installing,
using and providing information to or through the SOFTWARE PRODUCT, you consent to all actions taken by us
with respect to such information in compliance with the Privacy Policy.

"RISA" as applied to structural engineering software is a trademark of RISA Tech, Inc.
“BCI” is a registered trademark of BOISE CASCADE WOOD PRODUCTS, L.L.C.
“Georgia-Pacific” is a registered trademark of Georgia-Pacific Corporation

"GPI" is a registered trademark of Georgia-Pacific Wood Products South LLC.

“iLevel” is a registered trademark of Weyerhaeuser NR Company.

“iLevel Trus Joist Microllam LVL” is a registered trademark of Weyerhaeuser NR Company.
“iLevel Trus Joist Parallam PSL” is a registered trademark of Weyerhaeuser NR Company.
“International Beams” is a registered trademark of International Beams, Inc.

"LPI" is a registered trademark of Louisiana-Pacific Corporation.

“Nordic” is a registered trademark of Les Chantiers de Chibougamau ltée.

“Pacific Woodtech” is a registered trademark of Pacific Woodtech Corporation.

“Red” is a registered trademark of REDBUILT, LLC

“Rebuilt” is a registered trademark of REDBUILT, LLC

"RFPI" is a registered trademark of Roseburg Forest Products.

“TimberStrand Trus Joist” is a registered trademark of Weyerhaeuser NR Company.

“TJI” is a registered trademark of Weyerhaeuser NR Company..

Maintenance (Perpetual License Only)
Program maintenance provides all upgrades to RISA-3D.

When your maintenance expires, you will be given the opportunity to continue program maintenance on an
annual basis. You are under no obligation to continue program maintenance, of course, but if you decide to dis-
continue maintenance you will no longer receive RISA-3D program upgrades and technical support. In the event
maintenance is discontinued, reinstatement of maintenance will require payment of an "upgrade" fee.

Complete program support is available to registered owners of RISA-3D and is included in the purchase price.
This support is provided for the life of the program. See Technical Support for a list of your support options.

The “life of the program” is defined as the time period for which that version of the program is the current ver-
sion. In other words, whenever a new version of RISA-3D is released, the life of the previous version is con-
sidered to be ended.
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RISA Tech, Inc. will provide technical support only for the current version of RISA-3D.
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The Tutorials (a separate document) contain a tutorial that leads you through the RISA-3D interface with an
actual model. Consider going through the tutorial if you have not done so already, as it is the fastest way to
learn the program. Although it requires some time up front, the tutorial will save you time and brainpower in
the long run.

The features that are available to you in RISA-3D may be accessed through the main menu, shortcut menus, tool-
bars and shortcut keystrokes. You may use any or all of these vehicles to interact with the software. The main
menu has the advantage of containing all of the program options and features and may initially be the simplest
to use, letting you learn just one system. The toolbars contain more common options and invoke with one click.
The shortcut menus present options relevant to the task at hand. The shortcut keys provide a fast way to access
features should you use the program often enough to make them familiar to you. All of these features are dis-
cussed in the sections below. There are many ways to access features and the method that you will use will
simply be a matter of personal preference. The good news is that you have the options.

The bar along the top of the screen is called the title bar and contains the name of the file that is currently open.
The three buttons =181 Xl on the far right side of the title bar are used to control the main window. The left
button will shrink the main application window to a button on the taskbar. The middle button will shrink or max-
imize the window on your screen. The right button will close the window, prompting you to save changes if neces-
sary. You will also see these buttons in other windows and they have basically the same functions there as well.

The actual work that you do will be in the main area on the screen, which is called the workspace. When you
open a model view, a spreadsheet or a dialog it will be opened in the workspace and listed in the Window menu.
You may have as many windows open as you like.

Main Menu

All of the program features may be accessed through the main menu system at the top of the screen beginning
with File on the far left and ending with Help or possibly Director on the far right. Clicking on each of these
menus (listed below) will display sub-menus that contain options that you may choose from. You may also select
the main menus by using the ALT key along with the underlined letter in the menu you wish to choose. You may
then continue to use the keyboard to choose from the menu options. In addition, some of the menu options will
have hot key combinations listed to the right of the option. These hot keys allow you to use the keyboard to
access features without using the menu system.

File Menu

New will close the current file, prompting for saving if necessary, and will open a new file.
Open will close the current file, prompting for saving if necessary, and will open an existing file.
Save will save the current file, prompting for a name if necessary.

Save As will save the current file, prompting for a name.

Append will insert another RISA-3D model into the current model.

Import will close the current file, prompting for saving if necessary, and will open an existing RISA-2D (R2D),
DXF, or STD file.

Export will export the current file to a DXF or SDNF file.
For more information on the interaction between RISA and other programs refer to Appendix E.
Print will access RISA-3D printing options.

Page Setup will present page setup options for printing.
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Recent Files The five most recent files will be listed at the bottom of the menu. Selecting one of these files will
close the current file, prompting for saving if necessary, and will open the selected file.

Exit will close RISA-3D, prompting for saving if necessary.

Edit Menu

Undo will undo the last edit that was applied to the model whether it was made graphically or in the spread-
sheets. You may continue to apply Undo to remove up to 100 model edits.

Redo will reverse the last undo that was applied to the model. You may continue to apply Redo to remove up to
100 undo operations.

Select Allwill highlight an entire spreadsheet all at once.

Copy will copy the selected spreadsheet cells or model view from the active window to the clipboard.
Paste will paste data from the clipboard to the spreadsheet cells.

Insert Line will insert a new line in the spreadsheet beneath the current line.

Delete Line will delete the current spreadsheet line.

Repeat Line will insert a new line in the spreadsheet beneath the current line and copy the data from the cur-
rent line.

Mark All Lines will select all of the lines in the spreadsheet.
Unmark Lines will unmark any currently marked lines.

Delete Marked Lines will delete the marked lines in the spreadsheet.
Find will locate an item on the spreadsheet by its label.

Sort will sort the column containing the active cell.

Fill Block will fill the marked block of cells with a valid entry.

Math on Block allows you to add, subtract, multiply or divide the values in the marked block of cells.

Settings

Settings opens the Model Settings.

Units

Units opens the Units settings.

View Menu

New View will open a new model view window.

Save or Recall Views allows you to save a view or recall a view that has previously been saved.
Clone View makes a copy of the current view so you can modify one and maintain the other.
Refresh All will refresh all of the windows that are open in the workspace.

Select provides graphic select options that are also provided on the Selection Toolbar.
Unselect provides graphic unselect options that are also provided on the Selection Toolbar.

Save or Recall Selection States allows you to save a selection or recall a selection that has previously been
saved.

Zoom provides options for zooming in and out of the current model view.

Rotate provides options to snap the model view to global planes or an isometric view.
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Model Display Optionsopens the Model Display Options.

Render will turn rendering of the current model view on or off, depending on the current setting.
Drawing Grid will turn the display of the Drawing Grid on or off, depending on the current setting.
Project Grid will turn the display of the Project Grid on or off, depending on the current setting.

Axes will turn the display of the global axes in the model view on or off, depending on the current setting.
Boundaries will turn the display of the boundary conditions on or off, depending on the current setting.
Loads will turn the display of the model loads on or off, depending on the current setting.

Joint Labels will turn the display of the joint labels on or off, depending on the current setting. A third setting is
also available where the joints themselves are not shown at all.

Member Labels will turn the display of the member labels on or off, depending on the current setting. However,
if rendering is turned on, member labels will not be visible in the model view.

Insert Menu

The Insert Menu will help you insert new items into the model. Most of the options will provide a graphical
method of insertion but some will open spreadsheets where appropriate. See Graphic Editing for specific inform-
ation.

Modify Menu

The Modify Menu will help you modify existing items in the model. Most of the options will provide a graphical
method of modification but some will open spreadsheets where appropriate. The Delete Items Dialog may also
be accessed via this menu. See Graphic Editing for specific information.

Spreadsheets Menu

The Spreadsheets Menu provides access to any of the input spreadsheets. See Spreadsheet Operations to learn
how to work within the spreadsheets.

Solve Menu

Clicking on the Solve Menu will immediately begin a solution to the model. See Solution for more information.

Results Menu

The Results Menu provides access to any of the results spreadsheets. See Results Spreadsheets for more inform-
ation.

Tools Menu

Relabel Joints assigns new labels to the joints in their current order in the Joint Coordinates spreadsheet.
Relabel Members assigns new labels to the members in their current order in the Members spreadsheet.
Relabel Plates assigns new labels to the plates in their current order in the Plates spreadsheet.

Relabel Wall Panels assigns new labels to the wall panels in their current order in the Wall Panels spreadsheet.
Full Model Merge will merge the entire model. See Model Merge for more information.

Align Wall Panel will perform a merge of the wall panels to make sure they are lined up in the vertical dir-
ection. Use this utility if you are receiving wall panel errors at solution.
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Degenerate Plate Check... brings up a dialog that will allow you to scan through all plates in the model, looking
for odd/misshapen plates and giving the capability to fix these problems. See the Plates topic for more inform-
ation.

Round off joint coordinates will round off the coordinates.

Delete all Wall Panel Regions will delete the regions on all wall panels. The regions will be automatically regen-
erated next time the model is solved.

Switch Vertical Axes allows you to switch your vertical axis while maintaining consistent member orientation.

Detach RISA3D from RISAFloor allows you to take a RISA-3D model that is linked to RISAFloor and “detach” it
so that you can open / edit it without first going through RISAFloor.

Application Settings contain settings that let you customize the program. See Customizing RISA for more inform-
ation.

Customize Toolbar... allows you to modify the model view toolbar by adding, subtracting and re-ordering but-
tons. See the customizable toolbar section.

Reset All Program Defaults will reset all customized settings to the original factory settings.

Window Menu

In order to help you work with the model and the results, you are provided with many window arrangements to
choose from. You may access them from the Window Menu. The best way to understand just what these 'tilings’
do is to try them. Remember that once you choose a tiling you may adjust any of the windows as you wish. You

may also use the Tile M button on the RISA Toolbar to access a list of tilings.

Help Menu

Help Topics opens the RISA-3D Help File so that you may search the contents and the index. See Help Options to
learn about getting help.

Check for Update runs an internal check for possible program updates. If your program is up to date, you will
receive a message saying you are up to date. If you are out of date, the check will offer you the option to email
RISA Tech, Inc. for upgrade information if you are out of date for a major update. If you are out of date just a
minor update, then we will send you to our website to upgrade.. This check is also offered during the installation
process.

Licensing gives information about your subscription license and the option to Borrow or Return a license from
your subscription.

About provides RISA-3D version and hardware key information.

Director Menu

File Edt Global Units Wiew Insert Modify Spreadsheets Solve Resulfs  Tools Window  Help Director

If you are working from within the RISA Building System (RBS), use this menu to switch between RISAFloor,
RISA-3D and RISAFoundation. If you are not working within the RISA Building System, the Director Menu will not
be shown.

The directory button is located at the far, far right hand side of the Main Menu Toolbar as shown in the image
above.

Shortcut Menu

The Shortcut Menu is also referred to as the Right-Click Menu. This is because to access the shortcut menu you
simply click the RIGHT mouse button where you are working to see options that are relevant to what you are
doing. For example if you are working in a model view the right click menu will provide options to help you
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modify the view and edit the model graphically. If you are working in a spreadsheet the menu will provide edit-
ing tools for that spreadsheet.

This menu will appear wherever you RIGHT click the mouse. This way you do not need to move away from
where you are working to select the features you want to use.

Toolbars

The Toolbars provide buttons to help you access common commands and popular options in the menu system dis-
cussed above. There are different toolbars that will appear as you work to build your model and browse your
results. If at any time you are not sure what a particular button does, simply let your mouse hover over the but-
ton and a helpful tip will pop up and explain the button.

RISA Toolbar
DR B & -~ | @,

TuDDEE BE @ ke =22 008 ]

The first horizontal toolbar located just below the Main Menu is called the RISA Toolbar. The buttons on this
bar facilitate file and window access. You may use these buttons to open files and windows and also to analyze
the model.

Window Toolbar
[ Y R =y R T - -1 N B A A €2 R R E.‘ [y —r+|E||_C'1Z j@
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The Window Toolbar is the second horizontal toolbar located below the Main Menu. It gets its name because
the buttons change as you move from window to window in order to help you with what you are currently doing.
When you are working in a model view the buttons provide viewing tools, such as Rotate and Zoom, to assist
you with that view. There are also many other results and information display toggles, including some icons with
the drop down arrow next to them. Clicking the arrow will show you the different view options for that icon.
Clicking the icon itself will bring you back to the default view. Note that this model view toolbar is now fully cus-
tomizable. See below for more information.

Other model view windows that are open will not be affected so that each may show different information. When
you are working in a spreadsheet, editing tools are provided that are appropriate to that particular spreadsheet.
Note that not all tools are available with all spreadsheets. In fact there are many tools that are provided for one
spreadsheet only. See Spreadsheet Operations for more information.

Note:

. - This button will allow you to take a snapshot of the current detail report you are viewing so that it
can be added to a report. View the Printing topic for more information.

Customizable Model View Toolbar

The model view toolbar is fully customizable. By creating your personalized toolbar, you can quickly access your
most frequently used buttons. This can be done quickly and easily in just a few steps.

1. Go to Tools menu and select Customize Toolbar.
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Solve Resul
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GRS ReLabel Wall Panels...

Relabel Solids...

Full Model Merge...

Align Wall Panel...

Round Off Joint Coordinates...

Switch Vertical Axes (Y<->Z)...

Rreferences

Customize Toolbar...

Reset All Program Defaults...

2. Select one of the toolbars by clicking in the box Available toolbar buttons, and click on Add to place them
on the current toolbar.
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3. Once you've moved the buttons to the Current Toolbar, you can rearrange them by clicking on Move Up or
Move Down.

|
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Separator - @ Grid -
?“ Reactions | Diaphragm

Reset |
ML Member Input Label = Add > | " Member 1) Help |
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4. Click Close and you will see your selections on the model view toolbar.

Note:
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o You must have a model view as the current view to see this toolbar.
« If you add more buttons than will fit on the toolbar the buttons that are at the end of the "Current toolbar

buttons” will be cut off.

o The changes you have made will automatically be saved on a per-user (Windows User) basis, such that
next time you open the program the toolbar will be arranged per your Application Settings. These saved
changes are saved in the registry in the HKEY_CURRENT_USER\Software\RISA Technologies\RISAPro-
gram location with a String Value called "ToolbarState".

For additional advice on this topic, please see the RISA News website: www.risanews.com. Type in Search
keywords: Customized Toolbar.

Selection Toolbar

The vertical toolbar on the left side of the screen is the Selection Toolbar. This toolbar will only be available
when the active window is a model view. The buttons on this toolbar help you select and unselect items in the
model in order to help you build and modify the model or view results. See Graphic Selection for more inform-
ation.

L @mET
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Drawing Toolbar
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Another toolbar that is available is the Drawing Toolbar. Unlike those mentioned above, this toolbar is located
in the model view windows rather than in the main application window. This way the drawing tools stay close to
where you are working. This toolbar controls modeling features that help you draw, load, and modify your model
graphically. You may have more than one view open and a Drawing Toolbar for each view. This way you can sim-
ultaneously draw plates in one window and members in another.

The Drawing Toolbar may be displayed in any model view window by clicking 2 on the Window Toolbar
while in the model view window. Some of the buttons on the toolbar are for one-time applications such as modi-
fying the drawing grid. Other buttons place you in an editing mode, such as Draw Members, that remains active
until you cancel it. The current mode is indicated by the mouse pointer and by the state of the button. While in
an editing mode the button will stay down until you click it again or choose another button. See Graphic Editing
for more information.
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This brings us to an important point. Some of the toolbar buttons remain down when you press them to indicate
that you are in a certain mode or that something is either on or off. For example the Box Zoom &l button will
stay down to indicate that you are currently in the zooming mode. The Show Drawing Toolbar & button will
remain down when you turn on this toolbar for the active window. You may be in more than one mode at the
same time as long as they are not mutually exclusive.

Data Entry 7| WliResults E

Froject Grid Joint Reactions
Data Entey E| hatarials Joint Deflections
Froiect 5nd Section Sets Story Drift
Materials temher Design Rules Member Forces
Ceclion Sets Wall Desigh Rules Memhber Stresses
Member Design Rules Seismic Design Rules Member Torsion
Wall Design Rules Connection Rules Memhber Deflections
Seismic Desigh ROles Footing Definitions Suggested Shapes
TR Joint Coordinates Design Results
Footing Defintions Elnund_arg.r Conditions Seismic Dgtailin_g
TontCoordinates OR Diaphradms Concrete Reinforcing
Boundary Condiions Members Plate Stresses
Dlaphiagme Plates Flate Forces
Members Wall Fanels Flate Corner Forces
Basic Load Cases Solid Stresses
Plaites Joint Loads Solid Principals
Wall Panels FPoint Loads Wall Panel Design
Basic Load Cases Distibuted Loads Watarial TakeOfm
Maving I_.Dad.s MemberArea Loads Erequencies
Load Combinations Surface Loads Wode Shapes
Moving Loads Footings
Load Cambinations Connection Results

The Data Entry Toolbar is the vertical toolbar on the right side of the application window. It contains buttons
that facilitate data entry through the spreadsheets. The buttons on this toolbar provide quick access to the
spreadsheets that are also listed in the Spreadsheets Menu. You may open and close the toolbar by clicking the

E button on the RISA Toolbar.
Note
o Some of the Loads buttons have been removed. However, there is now an option in the Tools-Application

Settings dialog that will allow you to add these buttons back. These spreadsheets can also be easily
accessed from the Basic Load Cases spreadsheet.

For additional advice on this topic, please see the RISA News webpage at risa.com/news. Type in Search
keywords: Data Entry.

The Results Toolbar is the vertical toolbar on the right side of the application window that is placed over the
Data Entry Toolbar after the model has been solved. The buttons on this toolbar provide quick access to the res-
ults spreadsheets that are also listed in the Results Menu. You may open and close the toolbar by clicking the

button on the RISA Toolbar.
Note

« If the solution run is a Batch with Envelope solution then two sets of results spreadsheets are available
in many cases. Pressing the Results Toolbar buttons twice will open up both of these spreadsheets. Press-
ing the Member Forces button once, for example, would open the Envelope Member Forces spreadsheet.
Pressing Member Forces again would open the Batch Member Forces.

Dynamic View Controls

When your current window is a graphical model view, you can use the mouse wheel to dynamically zoom, pan, or
rotate the graphical image. These functions are only available to users who have a mouse with a wheel button
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and whose computers are running the Windows XP operating system.

Mouse Action Model View Function
Rolling the Wheel Forward Zoom In
Rolling the Wheel Backward Zoom Out

Clicking and holding the Wheel But-| Grab the image and pan in the direction
ton of mouse movement

Click and hold the Wheel button | Dynamically rotate the structure in the
while pressing the Shift key direction of mouse movement

Dynamic Pan: Clicking and holding the mouse wheel button triggers the tool and allows the user to pan or drag
the view to the limit of scroll bars.

Dynamic Zoom: This tool uses the wheel button on the mouse. Rotating forward zooms in and rotating backward
zooms out.

Dynamic Rotate: This tool is triggered by clicking and holding the mouse wheel button while holding the Shift
key. The rotational movement will be based on the how the user drags the mouse cursor over the screen and the
projection of global axis on the screen. For rotation about X axis, drag the cursor perpendicular to the projection
of the global X axis. The same logic applies for Y or Z axis rotations. When rotation is initiated, the system locks
for rotation about that axis until the user releases the middle mouse button.

Zoom Previous/Next: Function keys F3 and F4 are associated with Zoom Previous and Zoom Next respectively.
The system holds a doubly linked list of zoom info. This list has 10 zoom-states in the list. The F3 or F4 key-
stroke moves the active pointer forward or backward on the list. Each window has its own zoom list.

Dynamic Distance Tool: This tool triggers by pressing the F5 key. The user has to pick up two points on the
screen and the system gives back the total and partial distance between points on the status bar.

Shortcut Keys and Hot Keys

Shortcut Keys and Hot Keys allow you to use the keyboard to quickly access features. The difference between
the two is simply that the shortcut keys are related to a specific window and will only work in that window
while the hot keys will perform at most any time.

General Hot Keys
Key Combination Function
F1 Help on the active window
F5 Activates the Dynamic Distance Tool
Ctrl-F1 Main Help topics
Ctrl-F2 Create New view
F7, Ctrl-F7 Opens solution choices
Ctrl-Alt-F7 Replace shapes with suggested shapes and
re-solve the model
Ctrl-C Copy to the clipboard
Ctrl-v Paste from clipboard
Ctrl-N Start a new file
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Key Combination Function
Ctrl-0 Open an existing file
Ctrl-S Save the current file
Ctrl-P Print
Ctrl-Z Undo
Access the menus by combining the Alt key
Alt- , ) :
with the underlined letter in the menu

Shortcut Keys available for Specific Windows

Spreadsheet

Key Combination

Model View Window

Spreadsheet

Ctrl-D Open last graphic editing dialog [ Delete Marked Lines
Ctrl-G Toggle Drawing Toolbar
Ctrl-A Select All Select All
Ctrl-U Unselect all
Ctrl-F Block Fill
Ctrl-M Block Math
Ctrl-I Invert Selection
Ctrl-L Toggle Lock unselected Unmark lines
Ctrl-Enter Press cell ¥ button
F2 Open Model Display Options Start/Stop Cell Edit
F3 Insert line
F4 Delete Line
F5 Initiates the "Distance"” tool Find
F8 Repeat Current Line
+ Zoom In
- Zoom Out
~—1! PgUp PgDwn Scrolling Scrolling

Hot Keys that open spreadsheets

Key Combination

Unsolved Model

Solved Model

Ctrl-Alt-B Basic Load cases

Ctrl-Alt-C Joint Coordinates Corner Forces
Ctrl-Alt-D Distributed Loads Joint Deflections
Ctrl-Alt-E Members - Primary Data Member Deflections
Ctrl-Alt-F Member Forces
Ctrl-Alt-G Model Settings

Ctrl-Alt-H Model Generation Suggested Shapes

General Reference Manual
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Key Combination Unsolved Model Solved Model
Ctrl-Alt-1 Diaphragms Member Torsion
Ctrl-Alt-] Wall Panel Rules Solid Principal Stress
Ctrl-Alt-K Solid Stresses
Ctrl-Alt-L Load Combinations Plate Forces
Ctrl-Alt-M Materials Material Take Off
Ctrl-Alt-N Joint Loads Concrete Reinforcing
Ctrl-Alt-0 Boundary Conditions Mode Shapes
Ctrl-Alt-P Member Point Loads Plate Stresses
Ctrl-Alt-Q Frequencies
Ctrl-Alt-R Design Rules Reactions
Ctrl-Alt-S Section Sets Member Stresses
Ctrl-Alt-T Story Drift
Ctrl-Alt-U Seismic Design Rules Design Results
Ctrl-Alt-V Moving Loads
Ctrl-Alt-X Surface Loads
Ctrl-Alt-Y Dynamics Settings
Ctrl-Alt-Z Area Loads
Ctrl-Alt-4 Plates

Status Bar
I Elawit (Young's) Modulos ki

The Status Bar passes useful information to you as you work. It is divided into four parts located along the very
bottom of the main application window, just beneath the workspace.

The left side of the status bar shows a solution flag to indicate the solved state of the model as follows:

Solution Type Unsolved Solved
Static 8
Dynamic B
Response Spectra R

To the right of the solution flags there are three message boxes.

The first and largest box lets you know what you are currently doing. If you are in a spreadsheet, this box will
contain the explanation of the current cell. If you are working in a model view and select a graphic editing
option, look to this box for information on how to use the feature.

The second box is used to pass you units of the current spreadsheet cell.

The third box indicates the coordinates of the mouse when a model view is active. The mouse coordinates that
are displayed are the coordinates of the grid point or joint that is nearest to the mouse.

Windows

Modeling the structure will take place within model views and spreadsheets, each in their own window that may
be moved around the workspace and sized as you wish. The ability to have multiple model views and multiple
spreadsheets open at one time is a powerful feature. The options in the Window Menu are provided to help you
manage these windows.
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These windows contain three buttons =1Z1X] in the upper right corner to help you minimize, maximize and
close the window, respectively. There are also scroll boxes to help you view information that is outside of the
window viewing area. Click the scroll bar buttons or drag the scroll box to advance the display in one direction
or another.

Model Views

Model View windows show a graphic view of the model. Open a new view with the E button.

You may open as many model view windows as you like. This is especially helpful when working in close on
large models. You might have one overall view and a few views zoomed in and rotated to where you are cur-
rently working. You may also have different information plotted in multiple views.

One thing to remember is that the toolbars that are displayed depends upon what window is active. The active
window is the one with the blue title bar. For example, if you are looking for the zoom toolbar button and the act-
ive window is a spreadsheet you need to select a model view first before you can access the zooming tools.

Spreadsheets

Spreadsheet windows are made up of rows and columns of data cells. If you wish to add or edit data in a spread-
sheet cell you click on the cell, making it the active cell, and then edit the cell. This active cell is simply the
green cell that moves around the spreadsheet as you hit the cursor keys (<, =), Page Up, Page Down, Home,
End, etc. There is always one and only one active cell, which is the cell that has the “attention” of the keyboard.

You may also select blocks of data to work on. You can select a block of data by clicking and holding the mouse
button on the first cell in the block and then dragging the mouse to the opposite corner of the block and releas-
ing the mouse.

Dialogs

A Dialog is a third type of window and is used to access a specific function within the program. Another powerful
feature is that most of the dialogs may be left open while you edit the model, making it easy to make adjust-
ments as you work. You will find that dialogs are very easy to work with. There are Help buttons that will bring
you directly to the relevant topic in the help file.

Window Tiling

Standard window tilings help you set up your workspace. Select the Tile M button and then select a tiling
or choose them from the Window » Special Tiling menu.

The standard tilings include arrangements of spreadsheets and model view windows for creation of models and
viewing results. Each of these groups have arrangements for working with joints, members, and plates and also
loads. The best way to learn what these tilings do is to try them.

Modes

There are three basic program modes (View, Select, and Edit) and a mode hierarchy to allow you to move
between them easily. While you are editing the model you may select items to edit. When you are finished
selecting you will be returned to editing. Likewise, while you are selecting items you can adjust the view and
then be returned to selecting.

Different mouse cursors are used with each mode to make it clear what the current mode is.

View Mode is the upper level mode that allows you to adjust the view by zooming in and out, rotating and set-
ting Model Display Options. This mode supersedes all other modes so that you may do these things at any time,
and then be returned to the previous mode. This mode does not cancel other modes so that when you are fin-
ished adjusting the view you are returned to what you were doing. See Graphic Display for more information.

General Reference Manual 17



Application Interface

Select Mode is the middle level mode that allows you to make a graphic selection of joints, members and plates.
This mode supersedes the Edit Mode but not the View Mode. This means that you can make a selection while in
the middle of editing the view and when you are finished you are returned to the editing feature that you were
using. It also means that you may adjust the view while remaining in the same Select Mode. See Graphic Selec-
tion for more information.

Edit Mode is the lower level mode that allows you to graphically edit the model. You may make selections and
adjust the view while in the edit mode such that when you are finished selecting you will be returned to the Edit
Mode. Some Edit Mode features have options on how you apply the edit. See Graphic Editing for more inform-
ation.

Note

o The default mode is the mode you are in if you are not in any other mode and is indicated by the
standard ' mouse cursor. The default mode is a selection mode where you can select/unselect indi-
vidual items by clicking on them. You may also double-click on an item to view information about the
item.

« You may use the ESC key or the right mouse button to cancel a mode.
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Shapes are organized in the database by country. The shapes available are from the ADM 2005 Section Prop-
erties section. You may type in the names directly, select shapes from these databases or add your own shapes.

RISA currently supports the following common Cold Formed steel databases: Aluminum US, and Aluminum CAN.

Shape Selection

General ] Haot Ralled ] Cold Farmed ] Waood ] Cancrete

AAI3H2.03
AR 14231
AR 144279
AA1EK3TO
AR 1EX4.03
AR BK4.89
AL ITHE.80
AL IEHE.18
AL IEKT.02
AA 194836
AA10KE.65
AANOX10.3
AANZNT
AANZH143
AA 4160
WE2R1.43
WF4X4.76

WFSRE.49
MEEYA 1R

W

o ]

Shape Type
I+ \WF
iz

1T

" Bolid Rectangle
L

(D) 3in

[ 2.5 in
Database ! Manufacturer
|Aluminum us j

Y Y

Aluminum ]

z5

G5 (Back-Back)
5 (Front-Front)
Round Tube
Rect Tube

Add

Delete
[T

Edit

[ Make Default Database

cancel | Help |

X

To Select a Cold Formed Database Shape

1.

From the AluminumSection Sets tab on the Spreadsheet, or the Primary tab of the Members Spread-

sheet move the cursor to the Shape field and click L]
Specify the database and shape type you wish to use and then select from the list of available shapes by

clicking on |

Database Files

The aluminum shape databases are stored in the files ADMdbUS32.fil and ADMdbCAN32.fil.
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Add Shape X
Basic Properties

Shape Name | WF 8x10

Depth | 5 in
Flange Width | & in
2 Flange Thick | 125 in
—
Web Thick | .25 in

—p —

Calculated Properties
Area in"2 cw in"6 cElErmTE
lyy o “’ I Clear Fields
lz=z in*4

J in"4
Elastic Mod yy in"3
Elastic Mod zz in"3

Ok | Cancel Units Help

To Add a Database Shape

1. On the RISA Toolbar click the Edit Shape Database g button.
2. Select the Aluminum tab, then select the shape type you wish to add and click the Add button.
3. Specify a name for the shape and fill in the Basic Properties.
4. Click Calc Props to determine the shape properties.
Note

« Alterations to the shape database are not permanent unless you agree to save them. Changes that
are not saved only remain valid for the current session and will not be present the next time you
start RISA.

o New shapes are added to the bottom of the database.

o To delete a shape, specify the database and shape type you wish to delete and then click the Delete
button.

« To edit a shape, click the Edit button and edit the shape properties. Values can only be manually
edited here, nothing will be recalculated. If you wish to have all the values for a shape recalculated,
you will need to delete the shape and then add it again with the new properties.

Aluminum Shape Types

There are ten types of shapes. Names for each shape type follow the convention of the manufacturer for each
shape. If you know the shape name, you can type the name directly into the Shape field on the

spreadsheets. Alternately you may click the ¥ button to look up a shape and select it.

WF sections

The wide flange shapes are called out by the designation given them in the aluminum manual. For example, if
you wanted to use a WF10x11.4 you would enter WF10X11.4 as the shape name in the database shape field. Alu-
minum Association Standard I-Beams(AA), American Standard(S), Army-Navy(A-N), Canadian(CAN) I-Beams and
Wide Flange shapes are available.
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Zee sections (2Z)

The Z shapes are called out by the designation given them in the ADM manual.

Tee sections (T)

The T shapes are called out by the designation given them in the ADM manual. Army-Navy (A-N) shapes are also
available.

Solid Rectangular

The Solid Rectangular sections or bar sections are defined by the user, there are no default shapes.

Angles sections (L)

Angles are entered with an "L" prefix. The syntax is "LlongXshortXthick", where "long" is the long leg length,
"short" is the short leg length, and "thick” is the thickness, in number of decimals. For example, L5X3X0.375 is a
5" by 3" angle 0.375" thick. Square End Angles (LS) shapes are also available.

Channel sections (CS)

The CS shapes are called out by the designation given them in the ADM manual. The Aluminum Association (AA),
American Standard Channels (C) and Car and Ship Building Channels (CS), Canadian Channels (CAN) are available.

Double Sections
The CS shapes are also available Back-to-Back or Front-to-Front orientation.

Note

o The program currently only performs an analysis of double sections and does not perform a code
check of any kind. This may be added into a future revision of the program.

Round Tube or Pipe (OD) or (NPS)

The Round Tube shapes are called out by the designation given them in the ADM manual. The Outer diameter
call out is used as well as the Nominal Pipe Size.

Rect Tube sections (RT)

The RT shapes are called out by the designation given them in the ADM manual.
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Full code checking can be performed on standard aluminum shapes, based on the following codes:

e Aluminum Design Manual 2015: Building and Bridge
e Aluminum Design Manual 2010: Building and Bridge
o Aluminum Design Manual 2005: Building and Bridge

Aluminum properties are available in the database and the values are based on the ADM values (See Aluminum
Database). You may also input your own basic shapes and the properties will be calculated automatically.

Design Parameters

The Aluminum tab on the MemberSpreadsheet records the design parameters for the aluminum code checks.

These parameters may also be assigned graphically. See Modifying Member Design Parameters to learn how to
do this.

(30 = [[= =
F'rimary] Advanced | Hot Rolled | Cold Formed ] Wood ] Concrete Beam | Concrete Column  Aluminum | RISAConnection
(4] [»]  Label Length... | Lbyy[f) Lbzzff] | Lcomptop... | Lcompbot.. | Ltorquel] | Ky | K= Cb | Function
1 M1 11 2 Lbyy Lateral
2 M2 5 2 Lbyy Lateral
3 M3 12.728 2 Lbyy Lateral
4 M4 4472 2 Lbyy Lateral

These parameters are defined for each aluminum member. The entries are explained below.

Label

You may assign a unique Label to all of the members. Each label must be unique, so if you try to enter the same
label more than once you will get an error message. You may relabel at any time with the Relabel options on
the Tools menu.

Shape

The member Shape or Section Set is reported in the second column. This value is listed for reference only and
may not be edited as it is dictated by the entry in the Section/Shape column on the Primary tab.

Length

The member Length is reported in the third column. This value may not be edited as it is dependent on the
member end coordinatelisted on the Primary Data tab. It is listed here as a reference for unbraced lengths
which are discussed in the next section.

Unbraced Length

See the Unbraced Lengths topic.

K Factors (Effective Length Factors)

See the Unbraced Lengths topic.

Sway Flags

See the Unbraced Lengths topic.
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Cm - Interactive Bending Coefficient

Cm Coefficients are described in Section 4.1.1 of the ADM code. If these entries are left blank, they will be auto-
matically calculated.

The Cm value is influenced by the sway condition of the member and is dependent on the member's end
moments, which will change from one load combination to the next, so it may be a good idea to leave these
entries blank.

Note:

o Cm only shows up in the spreadsheet for the 2005 codes